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NEW QUESTION 1
- (Exam Topic 3)
You have a deployment pipeline for a Power BI workspace. The workspace contains two datasets that use import storage mode.
A database administrator reports a drastic increase in the number of queries sent from the Power BI service to an Azure SQL database since the creation of the
deployment pipeline.
An investigation into the issue identifies the following:

 One of the datasets is larger than 1 GB and has a fact table that contains more than 500 million rows.

 When publishing dataset changes to development, test, or production pipelines, a refresh is triggered against the entire dataset.
You need to recommend a solution to reduce the size of the queries sent to the database when the dataset changes are published to development, test, or
production.
What should you recommend?

A. From Capacity settings in the Power Bl Admin portal, reduce the Max Intermediate Row Set Count setting.
B. Configure the dataset to use a composite model that has a DirectQuery connection to the fact table.
C. Enable the large dataset storage format for workspace.
D. From Capacity settings in the Power Bl Admin portal, increase the Max Intermediate Row Set Count setting.

Answer: B

Explanation: 
A composite model in Power BI means part of your model can be a DirectQuery connection to a data source (for example, SQL Server database), and another part
as Import Data (for example, an Excel file). Previously, when you used DirectQuery, you couldn’t even add another data source into the model.
DirectQuery and Import Data have different advantages.
Now the Composite Model combines the good things of both Import and DirectQuery into one model. Using the Composite Model, you can work with big data
tables using DirectQuery, and still import smaller tables using Import Data.
Reference:
https://radacad.com/composite-model-directquery-and-import-data-combined-evolution-begins-in-power-bi
https://powerbi.microsoft.com/en-us/blog/five-new-power-bi-premium-capacity-settings-is-available-on-the-por

NEW QUESTION 2
- (Exam Topic 3)
You have a Power Bi workspace named Workspacel in a Premium capacity. Workspacel contains a dataset. During a scheduled refresh, you receive the following
error message: "Unable to save the changes since the new dataset size of 11,354 MB exceeds the limit of 10,240 MB."
You need to ensure that you can refresh the dataset. What should you do?

A. Turn on Large dataset storage format.
B. Connect Workspace1 to an Azure Data Lake Storage Gen2 account
C. Change License mode to Premium per user.
D. Change the location of the Premium capacity.

Answer: D

Explanation: 
Assigning workspaces to capacities
Workspaces can be assigned to a Premium capacity in the Power BI Admin portal or, for a workspace, in the Workspace pane.
Note: Capacity limits
Workspace storage limits, whether for My Workspace or an app workspace, depend on whether the workspace is in shared or Premium capacity.
* Shared capacity limits
For workspaces in shared capacity:
There is a per-workspace storage limit of 10 GB.
Premium Per User (PPU) tenants have a 100 TB storage limit.
When using a Pro license, the total usage can’t exceed the tenant storage limit of 10 GB multiplied by the number of Pro licenses in the tenant.
* Premium capacity limits
For workspaces in Premium capacity:
There is a limit of 100 TB per Premium capacity. There is no per-user storage limit.
Workspace storage usage is shown as 0 (as shown in this screenshot) if the workspace is assigned to a Premium capacity.
Incorrect:
Not C: If your organization is using the original version of Power BI Premium, you're required to migrate to the modern Premium Gen2 platform. Microsoft began
migrating all Premium capacities to Gen2.
Reference: https://docs.microsoft.com/en-us/power-bi/enterprise/service-premium-capacity-manage-gen2 https://docs.microsoft.com/en-us/power-bi/admin/service-
admin-manage-your-data-storage-in-power-bi

NEW QUESTION 3
- (Exam Topic 3)
You use the Vertipaq Analyzer to analyze tables in a dataset as shown in the Tables exhibit. (Click the Tables tab.)
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The table relationships for the dataset are shown in the Relationships exhibit. (Click the Relationships tab.)

You need to reduce the model size by eliminating invalid relationships. Which column should you remove?

A. Sales[Sales Amount]
B. Sales[RowlD]
C. Sales[Sales ID]
D. Plan[RowlD]

Answer: B

Explanation: 
Sales[Row ID] has 858,786 missing keys and 858,789 Max From Cardinality.
Note: The Max From Cardinality column defines the cost of the relationship which is the amount of time DAX needs to transfer the filters from the dimensions table
to the fact table.
Reference: https://blog.enterprisedna.co/vertipaq-analyzer-tutorial-relationships-referential-integrity/

NEW QUESTION 4
- (Exam Topic 3)
You need to configure a source control solution for Azure Synapse Analytics. The solution must meet the following requirements:
• Code must always be merged to the main branch before being published, and the main branch must be used for publishing resource
• The workspace templates must be stored in the publish branch.
• A branch named dev123 will be created to support the development of a new feature. What should you do? To answer, select the appropriate options in the
answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: main
Code must always be merged to the main branch before being published, and the main branch must be used for publishing resources.
Collaboration branch - Your Azure Repos collaboration branch that is used for publishing. By default, its master. Change this setting in case you want to publish
resources from another branch. You can select existing branches or create new.
Each Git repository that's associated with a Synapse Studio has a collaboration branch. (main or master is the default collaboration branch).
Box 2: workspace_publish
A branch named dev123 will be created to support the development of a new feature. The workspace templates must be stored in the publish branch.
Creating feature branches
Users can also create feature branches by clicking + New Branch in the branch dropdown.
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By default, Synapse Studio generates the workspace templates and saves them into a branch called workspace_publish. To configure a custom publish branch,
add a publish_config.json file to the root folder in the collaboration branch.
Reference: https://docs.microsoft.com/en-us/azure/synapse-analytics/cicd/source-control

NEW QUESTION 5
- (Exam Topic 3)
You use Vertipaq Analyzer to analyze a model.
The Relationships tab contains the results shown in the following exhibit.

Use the drop-down menus to select the answer choice that completes each statement based on the information presented in the graphic.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Customer
There are 1804 invalid rows (records) in the Customer table. Box 2: 22
There are 22 missing keys.
Note: VertiPaq Analyzer in DAX Studio is useful in identifying referential integrity violations which slow
down your DAX codes. It helps you determine which table or column needs to be optimized and improved. Reference: https://blog.enterprisedna.co/vertipaq-
analyzer-tutorial-relationships-referential-integrity/

NEW QUESTION 6
- (Exam Topic 3)
You have a Power BI tenant.
You plan to register the tenant in an Azure Purview account.
You need to ensure that you can scan the tenant by using Azure Purview.
Which two actions should you perform? Each correct answer presents part of the solution. NOTE: Each correct selection is worth one point.

A. From the Microsoft 365 admin center, create a Microsoft 365 group.
B. From the Power Bl Admin center, set Allow live connections to Enabled.
C. From the Power Bl Admin center, set Allow service principals to use read-only Power Bl admin APIs toEnabled.
D. From the Azure Active Directory admin center, create a security group.
E. From the Power Bl Admin center, set Share content with external users to Enabled.

Answer: CD

Explanation: 
Scan same-tenant Power BI using Azure IR and Managed Identity in public network. Make sure Power BI and Microsoft Purview accounts are in the same tenant.
Make sure Power BI tenant Id is entered correctly during the registration.
From Azure portal, validate if Microsoft Purview account Network is set to public access.
From Power BI tenant Admin Portal, make sure Power BI tenant is configured to allow public network.
(D) In Azure Active Directory tenant, create a security group.
From Azure Active Directory tenant, make sure Microsoft Purview account MSI is member of the new security group.
On the Power BI Tenant Admin portal, validate if Allow service principals to use read-only Power BI admin APIs is enabled for the new security group.
Associate the security group with Power BI tenant Log into the Power BI admin portal.
Select the Tenant settings page.
(C) Select Admin API settings > Allow service principals to use read-only Power BI admin APIs (Preview). Select Specific security groups.
Select Admin API settings > Enhance admin APIs responses with detailed metadata > Enable the toggle to allow Microsoft Purview Data Map automatically
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discover the detailed metadata of Power BI datasets as part of its scans.
Reference: https://docs.microsoft.com/en-us/azure/purview/register-scan-power-bi-tenant

NEW QUESTION 7
- (Exam Topic 3)
You have a Power Bl dataset. The dataset contains data that is updated frequently. You need to improve the performance of the dataset by using incremental
refreshes.
Which four actions should you perform in sequence to enable the incremental refreshes? To answer, move the appropriate actions from the list of actions to the
answer area and arrange them in the correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application, chat or text message Description automatically generated
Step 1: Create RangeStart and RangeEnd parameters. Create parameters
In this task, use Power Query Editor to create RangeStart and RangeEnd parameters with default values. The default values apply only when filtering the data to
be loaded into the model in Power BI Desktop. The values you enter should include only a small amount of the most recent data from your data source. When
published to the service, these values are overridden by the incremental refresh policy.
Step 2: Apply a custom Date/Time filter to the data. Filter data
With RangeStart and RangeEnd parameters defined, apply a filter based on conditions in the RangeStart and RangeEnd parameters.
Before continuing with this task, verify your source table has a date column of Date/Time data type. Step 3: Define the incremental refresh policy for the table.
Define policy
After you've defined RangeStart and RangeEnd parameters, and filtered data based on those parameters, you define an incremental refresh policy. The policy is
applied only after the model is published to the service and a manual or scheduled refresh operation is performed.
Step 4: Publish the model to the Power BI service. Save and publish to the service
When your RangeStart and RangeEnd parameters, filtering, and refresh policy settings are complete, be sure to save your model, and then publish to the service.
Reference: https://docs.microsoft.com/en-us/power-bi/connect-data/incremental-refresh-configure

NEW QUESTION 8
- (Exam Topic 3)
You have a Power Bl report that contains one visual.
You need to provide users with the ability to change the visual type without affecting the view for other users. What should you do?

A. From Report setting, select Personalize visuals.
B. From Tabular Editor, create a new perspective.
C. From the Bookmarks pane, select Focus mode, and then select Add.
D. From Visual options in Report settings, select Use the modern visual header with updated styling options.

Answer: A

Explanation: 
Enable personalization in a report
You can enable the feature either in Power BI Desktop or the Power BI service. You can also enable it in embedded reports.
To enable the feature in Power BI Desktop, go to File > Options and settings > Options > Current file > Report settings. Make sure Personalize visuals is turned
on.

NEW QUESTION 9
- (Exam Topic 3)
You discover a poorly performing measure in a Power Bl data model.
You need to review the query plan to analyze the amount of time spent in the storage engine and the formula engine.
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What should you use?

A. Tabular Editor
B. Performance analyzer in Power Bl Desktop
C. Vertipaq Analyzer
D. DAX Studio

Answer: B

Explanation: 
Monitor report performance in Power BI Desktop using the Performance Analyzer. Monitoring will help you learn where the bottlenecks are, and how you can
improve report performance.
Monitoring performance is relevant in the following situations: Your Import data model refresh is slow.
Your DirectQuery or Live Connection reports are slow. Your model calculations are slow.
Slow queries or report visuals should be a focal point of continued optimization.
Reference: https://docs.microsoft.com/en-us/power-bi/guidance/monitor-report-performance

NEW QUESTION 10
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have the Power Bl data model shown in the exhibit. (Click the Exhibit tab.)
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Users indicate that when they build reports from the data model, the reports take a long time to load. You need to recommend a solution to reduce the load times
of the reports.
Solution: You recommend normalizing the data model. Does this meet the goal?

A. Yes
B. No

Answer: B

Explanation: 
Instead denormalize For Performance.
Even though it might mean storing a bit of redundant data, schema denormalization can sometimes provide better query performance. The only question then
becomes is the extra space used worth the performance benefit.
Reference: https://www.mssqltips.com/sqlservertutorial/3211/denormalize-for-performance/

NEW QUESTION 10
- (Exam Topic 3)
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You need to recommend an automated solution to monitor Power Bl user activity. The solution must meet the
following requirements:
• Security admins must identify when users export reports from Power Bl within five days of a new sensitivity label being applied to the artifacts in Power Bl.
• Power Bl admins must identify updates or changes to the Power Bl capacity.
• The principle of least privilege must be used.
Which log should you include in the recommendation for each group? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: the unified audit log in Microsoft 365
Security admins must identify when users export reports from Power BI within five days of a new sensitivity label being applied to the artifacts in Power BI.
Use the audit log
If your task is to track user activities across Power BI and Microsoft 365, you work with auditing in Microsoft 365 compliance or use PowerShell. Auditing relies on
functionality in Exchange Online, which automatically supports Power BI.
You can filter the audit data by date range, user, dashboard, report, dataset, and activity type. You can also download the activities in a csv (comma-separated
value) file to analyze offline.
Box 2: Power BI activity log
Power BI admins must identify updates or changes to the Power BI capacity. Use the activity log
Power BI administrators can analyze usage for all Power BI resources at the tenant level by using custom reports that are based on the Power BI activity log.
Reference: https://docs.microsoft.com/en-us/power-bi/admin/service-admin-auditing

NEW QUESTION 12
- (Exam Topic 3)
You have an Azure Synapse Analytics serverless SQL pool.
You need to catalog the serverless SQL pool by using Azure Purview.
Which three actions should you perform? Each correct answer presents part of the solution. NOTE: Each correct selection is worth one point.

A. Create a managed identity in Azure Active Directory (Azure AD).
B. Assign the Storage Blob Data Reader role to the Azure Purview managed service identity (MSI) for the storage account associated to the Synapse Analytics
workspace.
C. Assign the Owner role to the Azure Purview managed service identity (MSI) for the Azure Purview resource group.
D. Register a data source.
E. Assign the Reader role to the Azure Purview managed service identity (MSI) for the Synapse Analytics workspace.

Answer: ABE

Explanation: 
Authentication for enumerating serverless SQL database resources
There are three places you'll need to set authentication to allow Microsoft Purview to enumerate your serverless SQL database resources:
The Azure Synapse workspace The associated storage
The Azure Synapse serverless databases
The steps below will set permissions for all three. Azure Synapse workspace
In the Azure portal, go to the Azure Synapse workspace resource. On the left pane, selectAccess Control (IAM).
Select the Add button.
Set the Reader role and enter your Microsoft Purview account name, which represents its managed service identity (MSI).
Select Save to finish assigning the role
Azure Synapse Analytics serverless SQL pool catalog Purview Azure Purview managed service identity Storage account
In the Azure portal, go to the Resource group or Subscription that the storage account associated with the Azure Synapse workspace is in.
On the left pane, selectAccess Control (IAM). Select the Add button.
Set the Storage blob data reader role and enter your Microsoft Purview account name (which represents its MSI) in the Select box.
Select Save to finish assigning the role. Azure Synapse serverless database
Go to your Azure Synapse workspace and open the Synapse Studio. Select the Data tab on the left menu.
Select the ellipsis (...) next to one of your databases, and then start a new SQL script.
Add the Microsoft Purview account MSI (represented by the account name) on the serverless SQL databases. You do so by running the following command in
your SQL script:
SQL
CREATE LOGIN [PurviewAccountName] FROM EXTERNAL PROVIDER;
Apply permissions to scan the contents of the workspace
You can set up authentication for an Azure Synapse source in either of two ways. Select your scenario below for steps to apply permissions.
Use a managed identity Use a service principal
Reference: https://docs.microsoft.com/en-us/azure/purview/register-scan-synapse-workspace?tabs=MI

NEW QUESTION 15
- (Exam Topic 3)
You have an Azure Synapse Analytics dedicated SQL pool.
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You need to ensure that the SQL pool is scanned by Azure Purview. What should you do first?

A. Register a data source.
B. Search the data catalog.
C. Create a data share connection.
D. Create a data policy.

Answer: B

NEW QUESTION 18
- (Exam Topic 3)
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are using an Azure Synapse Analytics serverless SQL pool to query a collection of Apache Parquet files by using automatic schema inference. The files
contain more than 40 million rows of UTF-8-encoded business names, survey names, and participant counts. The database is configured to use the default
collation.
The queries use open row set and infer the schema shown in the following table.

You need to recommend changes to the queries to reduce I/O reads and tempdb usage.
Solution: You recommend using openrowset with to explicitly define the collation for businessName and surveyName as Latim_Generai_100_BiN2_UTF8.
Does this meet the goal?

A. Yes
B. No

Answer: A

Explanation: 
Query Parquet files using serverless SQL pool in Azure Synapse Analytics. Important
Ensure you are using a UTF-8 database collation (for example Latin1_General_100_BIN2_UTF8) because string values in PARQUET files are encoded using
UTF-8 encoding. A mismatch between the text encoding in the PARQUET file and the collation may cause unexpected conversion errors. You can easily change
the default collation of the current database using the following T-SQL statement: alter database current collate Latin1_General_100_BIN2_UTF8'.
Note: If you use the Latin1_General_100_BIN2_UTF8 collation you will get an additional performance boost compared to the other collations. The
Latin1_General_100_BIN2_UTF8 collation is compatible with parquet string sorting rules. The SQL pool is able to eliminate some parts of the parquet files that will
not contain data needed in the queries (file/column-segment pruning). If you use other collations, all data from the parquet files will be loaded into Synapse SQL
and the filtering is happening within the SQL process. The Latin1_General_100_BIN2_UTF8 collation has additional performance optimization that works only for
parquet and CosmosDB. The downside is that you lose fine-grained comparison rules like case insensitivity.
Reference: https://docs.microsoft.com/en-us/azure/synapse-analytics/sql/query-parquet-files

NEW QUESTION 22
- (Exam Topic 3)
You have a Power Bl workspace that contains one dataset and four reports that connect to the dataset. The dataset uses Import storage mode and contains the
following data sources:
• A CSV file in an Azure Storage account
• An Azure Database for PostgreSQL database
You plan to use deployment pipelines to promote the content from development to test to production. There will be different data source locations for each stage.
What should you include in the deployment pipeline to ensure that the appropriate data source locations are used during each stage?

A. parameter rules
B. selective deployment
C. auto-binding across pipelines
D. data source rules

Answer: A

Explanation: 
Note: Create deployment rules
When working in a deployment pipeline, different stages may have different configurations. For example, each stage can have different databases or different
query parameters. The development stage might query sample data from the database, while the test and production stages query the entire database.
When you deploy content between pipeline stages, configuring deployment rules enables you to allow changes to content, while keeping some settings intact. For
example, if you want a dataset in a production stage to point to a production database, you can define a rule for this. The rule is defined in the production stage,
under the appropriate dataset. Once the rule is defined, content deployed from test to production, will inherit the value as defined in the deployment rule, and will
always apply as long as the rule is unchanged and valid.

NEW QUESTION 25
- (Exam Topic 3)
You manage a dataset that contains the two data sources as shown in the following table.
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When you attempt to refresh the dataset in powerbi.com, you receive the following error message: “[Unable to combine data] Add Columns is accessing data
sources that have privacy levels which cannot be used together. Please rebuild this data combination.”
You discover that the dataset contains queries that fold data from the SharePoint folder to the Azure SQL database.
You need to resolve the error. The solution must provide the highest privacy possible.
Which privacy level should you select for each data source? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Private
This Formula.Firewall error is the result of Power Query’s Data Privacy Firewall (aka the Firewall)
Note: Folding is a term that refers to converting expressions in M (such as filters, renames, joins, and so on) into operations against a raw data source (such as
SQL, OData, and so on).
Box 2: Organizational
Organizational Limits the visibility of a data source to a trusted group of people. It is isolated from all Public data sources, but is visible to other Organizational data
sources. A common example is a Microsoft Word document on an intranet SharePoint site with permissions enabled for a trusted group.
Reference:
https://support.microsoft.com/en-us/office/set-privacy-levels-power-query-cc3ede4d-359e-4b28-bc72-9bee7900

NEW QUESTION 27
- (Exam Topic 3)
You are attempting to configure certification for a Power BI dataset and discover that the certification setting for the dataset is unavailable.
What are two possible causes of the issue? Each correct answer presents a complete solution. NOTE: Each correct selection is worth one point.

A. The workspace is in shared capacity.
B. You have insufficient permissions.
C. Dataset certification is disabled for the Power Bl tenant.
D. The sensitivity level for the dataset is set to Highly Confidential.
E. Row-level security (RLS) is missing from the dataset.

Answer: BC

Explanation: 
Reference: https://docs.microsoft.com/en-us/power-bi/admin/service-admin-setup-certification https://docs.microsoft.com/en-us/power-bi/collaborate-share/service-
endorse-content

NEW QUESTION 30
- (Exam Topic 3)
You are creating an external table by using an Apache Spark pool in Azure Synapse Analytics. The table will contain more than 20 million rows partitioned by date.
The table will be shared with the SQL engines.
You need to minimize how long it takes for a serverless SQL pool to execute a query data against the table. In which file format should you recommend storing the
table data?

A. JSON
B. Apache Parquet
C. CSV
D. Delta

Answer: B

Explanation: 
Prepare files for querying
If possible, you can prepare files for better performance:
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* Convert large CSV and JSON files to Parquet. Parquet is a columnar format. Because it's compressed, its file sizes are smaller than CSV or JSON files that
contain the same data. Serverless SQL pool skips the columns and rows that aren't needed in a query if you're reading Parquet files. Serverless SQL pool needs
less time and fewer storage requests to read it.
Reference: https://docs.microsoft.com/en-us/azure/synapse-analytics/sql/best-practices-serverless-sql-pool https://stackoverflow.com/questions/65320949/parquet-
vs-delta-format-in-azure-data-lake-gen-2-store

NEW QUESTION 33
- (Exam Topic 3)
You plan to modify a Power Bl dataset.
You open the Impact analysis panel for the dataset and select Notify contacts. Which contacts will be notified when you use the Notify contacts feature?

A. any users that accessed a report that uses the dataset within the last 30 days
B. the workspace admins of any workspace that uses the dataset
C. the Power Bl admins
D. all the workspace members of any workspace that uses the dataset

Answer: D

Explanation: 
 Notify contacts
If you've made a change to a dataset or are thinking about making a change, you might want to contact the relevant users to tell them about it. When you notify
contacts, an email is sent to the contact lists of all the impacted workspaces. Your name appears on the email so the contacts can find you and reply back in a new
email thread.
Reference: https://docs.microsoft.com/en-us/power-bi/collaborate-share/service-dataset-impact-analysis

NEW QUESTION 36
- (Exam Topic 3)
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are using an Azure Synapse Analytics serverless SQL pool to query a collection of Apache Parquet files by using automatic schema inference. The files
contain more than 40 million rows of UTF-8-encoded business names, survey names, and participant counts. The database is configured to use the default
collation.
The queries use open row set and infer the schema shown in the following table.

You need to recommend changes to the queries to reduce I/O reads and tempdb usage.
Solution: You recommend using openrowset with to explicitly specify the maximum length for businessName and surveyName.
Does this meet the goal?

A. Yes
B. No

Answer: B

Explanation: 
Instead use Solution: You recommend using OPENROWSET WITH to explicitly define the collation for businessName and surveyName as
Latin1_General_100_BIN2_UTF8.
Query Parquet files using serverless SQL pool in Azure Synapse Analytics. Important
Ensure you are using a UTF-8 database collation (for example Latin1_General_100_BIN2_UTF8) because string values in PARQUET files are encoded using
UTF-8 encoding. A mismatch between the text encoding in the PARQUET file and the collation may cause unexpected conversion errors. You can easily change
the default collation of the current database using the following T-SQL statement: alter database current collate Latin1_General_100_BIN2_UTF8'.
Note: If you use the Latin1_General_100_BIN2_UTF8 collation you will get an additional performance boost compared to the other collations. The
Latin1_General_100_BIN2_UTF8 collation is compatible with parquet string sorting rules. The SQL pool is able to eliminate some parts of the parquet files that will
not contain data needed in the queries (file/column-segment pruning). If you use other collations, all data from the parquet files will be loaded into Synapse SQL
and the filtering is happening within the SQL process. The Latin1_General_100_BIN2_UTF8 collation has additional performance optimization that works only for
parquet and CosmosDB. The downside is that you lose fine-grained comparison rules like case insensitivity.
Reference: https://docs.microsoft.com/en-us/azure/synapse-analytics/sql/query-parquet-files

NEW QUESTION 41
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have a Power Bl dataset named Datasetl.
In Datasetl, you currently have 50 measures that use the same time intelligence logic. You need to reduce the number of measures, while maintaining the current
functionality. Solution: From Power Bl Desktop, you group the measures in a display folder.
Does this meet the goal?

A. Yes
B. No

Answer: B

Explanation: 
Solution: From DAX Studio, you write a query that uses grouping sets.
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A grouping is a set of discrete values that are used to group measure fields. Reference: https://docs.microsoft.com/en-us/power-bi/developer/visuals/capabilities

NEW QUESTION 43
- (Exam Topic 3)
You have a Power BI Premium capacity.
You need to increase the number of virtual cores associated to the capacity. Which role do you need?

A. Power Bl workspace admin
B. capacity admin
C. Power Platform admin
D. Power Bl admin

Answer: D

Explanation: 
 Change capacity size
Power BI admins and global administrators can change Power BI Premium capacity. Capacity admins who are not a Power BI admin or global administrator don't
have this option.
Reference: https://docs.microsoft.com/en-us/power-bi/enterprise/service-admin-premium-manage

NEW QUESTION 46
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have a Power Bl dataset named Dataset1.
In Dataset1, you currently have 50 measures that use the same time intelligence logic. You need to reduce the number of measures, while maintaining the current
functionality. Solution: From Power Bl Desktop, you create a hierarchy.
Does this meet the goal?

A. Yes
B. No

Answer: B

Explanation: 
Instead use the solution: From DAX Studio, you write a query that uses grouping sets. A grouping is a set of discrete values that are used to group measure fields.
Note: A hierarchy is an ordered set of values that are linked to the level above. An example of a hierarchy could be Country, State, and City. Cities are in a State,
and States make up a Country. In Power BI visuals can handle hierarchy data and provide controls for the user to navigate up and down the hierarchy.
Reference: https://docs.microsoft.com/en-us/power-bi/developer/visuals/capabilities https://powerbi.tips/2018/09/how-to-navigate-hierarchies/

NEW QUESTION 50
- (Exam Topic 3)
You are running a diagnostic against a query as shown in the following exhibit.

What can you identify from the diagnostics query?

A. All the query steps are folding.
B. Elevated permissions are being used to query records.
C. The query is timing out.
D. Some query steps are folding.

Answer: A

Explanation: 
Understanding folding with Query Diagnostics
One of the most common reasons to use Query Diagnostics is to have a better understanding of what operations were 'pushed down' by Power Query to be
performed by the back-end data source, which is also known as 'folding'. If we want to see what folded, we can look at what is the 'most specific' query, or queries,
that get sent to the back-end data source. We can look at this for both ODATA and SQL.
Reference: https://docs.microsoft.com/en-us/power-query/querydiagnosticsfolding

NEW QUESTION 53
- (Exam Topic 3)
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You have a deployment pipeline for a Power BI workspace. The workspace contains two datasets that use import storage mode.
A database administrator reports a drastic increase in the number of queries sent from the Power Bi service to an Azure SQL database since the creation of the
deployment pipeline.
An investigation into the issue identifies the following:

 One of the datasets is larger than 1 GB and has a fact table that contains more than 500 million rows.

 When publishing dataset changes to development, test, or production pipelines, a refresh is triggered against the entire dataset.
You need to recommend a solution to reduce the size of the queries sent to the database when the dataset changes are published to development, test, or
production.
What should you recommend?

A. Request the authors of the deployment pipeline datasets to reduce the number of datasets republished during development.
B. In the dataset, delete the fact table.
C. Configure the dataset to use a composite model that has a DirectQuery connection to the fact table.
D. From Capacity settings in the Power Bi Admin portal, reduce the Max Intermediate Row Set Count setting.

Answer: C

Explanation: 
Previously in Power BI Desktop, when you used a DirectQuery in a report, no other data connections, whether DirectQuery or import, were allowed for that report.
With composite models, that restriction is removed. A report can seamlessly include data connections from more than one DirectQuery or import data connection,
in any combination you choose.
The composite models capability in Power BI Desktop consists of three related features:
* Composite models: Allows a report to have two or more data connections from different source groups, such as one or more DirectQuery connections and an
import connection, two or more DirectQuery connections, or any combination thereof.
* Etc.
Reference: https://docs.microsoft.com/en-us/power-bi/transform-model/desktop-composite-models

NEW QUESTION 55
- (Exam Topic 3)
You have a Power Bl dataset that contains two tables named Table1 and Table2. The dataset is used by one report.
You need to prevent project managers from accessing the data in two columns in Table1 named Budget and Forecast.
Which four actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Step 1: From Power BI Desktop, create a role named Project Managers. Create roles
You can define roles within Power BI Desktop. Step 2: Open Tabular Editor
Under Tables, select the table to which you want to apply a DAX rule.
In the Table filter DAX expression box, enter the DAX expressions. This expression returns a value of true or false. For example: [Entity ID] = “Value”.
Step 3: From Power BI Desktop, add a DAX filter to the Project Managers role. Step 4: For Table1, the Budget and Forecast columns, set the permissions to None.
Reference: https://docs.microsoft.com/en-us/power-bi/guidance/rls-guidance

NEW QUESTION 59
- (Exam Topic 3)
You are implementing a reporting solution that has the following requirements:
• Reports for external customers must support 500 concurrent requests. The data for these reports is approximately 7 GB and is stored in Azure Synapse
Analytics.
• Reports for the security team use data that must have local security rules applied at the database level to restrict access. The data being reviewed is 2 GB.
Which storage mode provides the best response time for each group of users?

A. DirectQuery for the external customers and import for the security team.
B. DirectQuery for the external customers and DirectQuery for the security team.
C. Import for the external customers and DirectQuery for the security team.
D. Import for the external customers and import for the security team.

Answer: A

Explanation: 
With DirectQuery, queries are sent back to your Azure Synapse Analytics in real time as you explore the data. Real-time queries, combined with the scale of
Synapse Analytics enables users to create dynamic reports in minutes against terabytes of data.
Need import for the security team for local security rules. Reference:
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https://docs.microsoft.com/en-us/power-bi/connect-data/service-azure-sql-data-warehouse-with-direct-connect

NEW QUESTION 61
- (Exam Topic 3)
You are building a Power Bl dataset that contains a table named Calendar. Calendar contains the following calculated column.
pfflag = IF('Calendar'[Date] < TOOAYQ, "Past", "Future")
You need to create a measure that will perform a fiscal prior year-to-date calculation that meets the following requirements:
• Returns the fiscal prior year-to-date value for [sales Amount]
• Uses a fiscal year end of June 30
• Produces no result for dates in the future
How should you complete the DAX expression? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: CALCULATETABLE
CALCULATETABLE evaluates a table expression in a modified filter context. Syntax: CALCULATETABLE(<expression>[, <filter1> [, <filter2> [, …]]]) Incorrect:
* SUMMARIZECOLUMNS
SUMMARIZECOLUMNS returns a summary table over a set of groups.
Syntax: SUMMARIZECOLUMNS( <groupBy_columnName> [, < groupBy_columnName >]…, [<filterTable>]…[, <name>, <expression>]…)
* CROSSJOIN returns a table that contains the Cartesian product of all rows from all tables in the arguments. The columns in the new table are all the columns in
all the argument tables.
Syntax: CROSSJOIN(<table>, <table>[, <table>]…)
* UNION creates a union (join) table from a pair of tables.
Syntax: UNION(<table_expression1>, <table_expression2> [,<table_expression>]…) Box 2: SAMEPERIODLASTYEAR
SAMEPERIODLASTYEAR returns a table that contains a column of dates shifted one year back in time from the dates in the specified dates column, in the current
context.
Syntax: SAMEPERIODLASTYEAR(<dates>)
The dates returned are the same as the dates returned by this equivalent formula: DATEADD(dates, -1, year) Example:
The following sample formula creates a measure that calculates the previous year sales of Reseller sales.
= CALCULATE(SUM(ResellerSales_USD[SalesAmount_USD]), SAMEPERIODLASTYEAR(DateTime[DateKey))
Box 3: TODAY()
TODAY() returns the current date.
The TODAY function is useful when you need to have the current date displayed on a worksheet, regardless of when you open the workbook. It is also useful for
calculating intervals.
Example:
The following sample formula creates a measure that calculates the 'Running Total' for Internet sales.
= CALCULATE(SUM(InternetSales_USD[SalesAmount_USD]), DATESYTD(DateTime[DateKey])) Reference: https://docs.microsoft.com/en-us/dax/calculatetable-
function-dax https://docs.microsoft.com/en-us/dax/sameperiodlastyear-function-dax
https://docs.microsoft.com/en-us/dax/datesytd-function-dax

NEW QUESTION 64
- (Exam Topic 3)
You develop a solution that uses a Power Bl Premium capacity. The capacity contains a dataset that is expected to consume 50 GB of memory.
Which two actions should you perform to ensure that you can publish the model successfully to the Power Bl service? Each correct answer presents part of the
solution.
NOTE: Each correct selection is worth one point.

A. Increase the Max Offline Dataset Size setting.
B. Invoke a refresh to load historical data based on the incremental refresh policy.
C. Restart the capacity.
D. Publish an initial dataset that is less than 10 GB.
E. Publish the complete dataset.
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Answer: BE

Explanation: 
 Enable large datasets
Steps here describe enabling large datasets for a new model published to the service. For existing datasets, only step 3 is necessary.
Create a model in Power BI Desktop. If your dataset will become larger and progressively consume more memory, be sure to configure Incremental refresh.
Publish the model as a dataset to the service.
In the service > dataset > Settings, expand Large dataset storage format, set the slider to On, and then select Apply.
Enable large dataset slider
Invoke a refresh to load historical data based on the incremental refresh policy. The first refresh could take a while to load the history. Subsequent refreshes
should be faster, depending on your incremental refresh policy.
Reference: https://docs.microsoft.com/en-us/power-bi/enterprise/service-premium-large-models

NEW QUESTION 68
- (Exam Topic 3)
You are using a Python notebook in an Apache Spark pool in Azure Synapse Analytics. You need to present the data distribution statistics from a DataFrame in a
tabular view. Which method should you invoke on the DataFrame?

A. rollup
B. cov
C. explain
D. describe

Answer: D

Explanation: 
The aggregating statistic can be calculated for multiple columns at the same time with the describe function. Example:
titanic[["Age", "Fare"]].describe() Out[6]:
Age Fare
count 714.000000 891.000000
mean 29.699118 32.204208
std 14.526497 49.693429
min 0.420000 0.000000
25% 20.125000 7.910400
50% 28.000000 14.454200
75% 38.000000 31.000000
max 80.000000 512.329200
Reference: https://pandas.pydata.org/docs/getting_started/intro_tutorials/06_calculate_statistics.html

NEW QUESTION 73
- (Exam Topic 3)
You plan to create a Power Bl report that will use an OData feed as the data source. You will retrieve all the entities from two different collections by using the
same service root
The OData feed is still in development. The location of the feed will change once development is complete. The report will be published before the OData feed
development is complete.
You need to minimize development effort to change the data source once the location changes.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated
Step 1: Create a parameter that contains the service root URI
Step 2: Get data from OData feed source and use the parameter to populate the first part of the URL. The URI is in the first part of the query.
Example: let
Source = OData.Feed
("https://analytics.dev.azure.com/{organization}/{project}/_odata/v3.0-preview/WorkItemSnapshot? "
&"$apply=filter( "
&"WorkItemType eq 'Bug' "
&"and StateCategory ne 'Completed' "
&"and startswith(Area/AreaPath,'{areapath}') "
&"and DateValue ge {startdate} "
&") "
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&"/groupby( "
&"(DateValue,State,WorkItemType,Priority,Severity,Area/AreaPath,Iteration/IterationPath,AreaSK), "
&"aggregate($count as Count) "
&") "
,null, [Implementation="2.0",OmitValues = ODataOmitValues.Nulls,ODataVersion = 4]) in
Source
Box 3: From Advanced Editor, duplicate the query and change the resource path in the URL. Choose Get Data, and then Blank Query.
From the Power BI Query editor, choose Advanced Editor. The Advanced Editor window opens.
Edit the query. Etc.
Reference: https://docs.microsoft.com/en-us/azure/devops/report/powerbi/odataquery-connect

NEW QUESTION 77
- (Exam Topic 3)
You have the following code in an Azure Synapse notebook.

Use the drop-down menus to select the answer choice that completes each statement based on the information presented in the code.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: three scatterplots Compare Plots
Example, Draw two plots on the same figure: import matplotlib.pyplot as plt
import numpy as np
#day one, the age and speed of 13 cars:
x = np.array([5,7,8,7,2,17,2,9,4,11,12,9,6])
y = np.array([99,86,87,88,111,86,103,87,94,78,77,85,86])
plt.scatter(x, y)
#day two, the age and speed of 15 cars:
x = np.array([2,2,8,1,15,8,12,9,7,3,11,4,7,14,12])
y = np.array([100,105,84,105,90,99,90,95,94,100,79,112,91,80,85])
plt.scatter(x, y) plt.show() Result:
Chart, scatter chart Description automatically generated
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Box 2: three marker symbols
One for each scatterplot. One default, and two defined.
Default is point.
v is triangle down.
^ is triangle up.
Reference: https://www.w3schools.com/python/matplotlib_scatter.asp https://matplotlib.org/stable/api/markers_api.html

NEW QUESTION 80
- (Exam Topic 3)
Note: This question is part of a scries of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have the Power Bl data model shown in the exhibit. (Click the Exhibit tab.)
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Users indicate that when they build reports from the data model, the reports take a long time to load. You need to recommend a solution to reduce the load times
of the reports.
Solution: You recommend creating a perspective that contains the commonly used fields. Does this meet the goal?

A. Yes
B. No

Answer: B

Explanation: 
Instead denormalize For Performance.
Even though it might mean storing a bit of redundant data, schema denormalization can sometimes provide better query performance. The only question then
becomes is the extra space used worth the performance benefit.
Reference: https://www.mssqltips.com/sqlservertutorial/3211/denormalize-for-performance/

NEW QUESTION 85
- (Exam Topic 3)
You are using an Azure Synapse Analytics serverless SQL pool to query network traffic logs in the Apache Parquet format. A sample of the data is shown in the
following table.

You need to create a Transact-SQL query that will return the source IP address.
Which function should you use in the select statement to retrieve the source IP address?

A. JS0N_VALUE
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B. FOR.JSON
C. CONVERT
D. FIRST VALUE

Answer: A

NEW QUESTION 90
- (Exam Topic 3)
You have a Power Bl dataset that uses DirectQuery against an Azure SQL database.
Multiple reports use the dataset.
A database administrator reports that too many queries are being sent from Power Bl to the database. You need to reduce the number of queries sent to the
database. The solution must meet the following
requirements:
• DirectQuery must continue to be used.
• Visual interactions in all the reports must remain as they are configured currently.
• Consumers of the reports must only be allowed to apply filters from the Filter pane. Which two settings should you select? Each correct answer presents part of
the solution. NOTE: Each correct selection is worth one point.

A. Disabling cross highlighting/filtering by default
B. Add a single Apply button to the filter pane to apply changes at once
C. Add an Apply button to each slicer to apply changes when you're ready
D. Add Apply buttons to all basic filters to apply changes when you're ready
E. Ignore the Privacy Levels and potentially improve performance

Answer: BC

Explanation: 
 Reduce queries
Reduce the number of queries sent by Power BI using the Query reduction settings. For slicers, select the “Add an Apply button to each slicer to apply changes
when you’re ready” option. For filters, select “Add a single Apply button to the filter pane to apply changes at once (preview).”
Reference: https://maqsoftware.com/insights/power-bi-best-practices

NEW QUESTION 95
- (Exam Topic 3)
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are using an Azure Synapse Analytics serverless SQL pool to query a collection of Apache Parquet files by using automatic schema inference. The files
contain more than 40 million rows of UTF-8-encoded business names, survey names, and participant counts. The database is configured to use the default
collation.
The queries use open row set and infer the schema shown in the following table.

You need to recommend changes to the queries to reduce I/O reads and tempdb usage.
Solution: You recommend defining an external table for the Parquet files and updating the query to use the table
Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 100
- (Exam Topic 3)
You have a dataset that contains a table named UserPermissions. UserPermissions contains the following data.

You plan to create a security role named User Security for the dataset. You need to filter the dataset based on the current users. What should you include in the
DAX expression?

A. [UserPermissions] - USERNAME()
B. [UserPermissions] - USERPRINCIPALNAME()
C. [User] = USERPRINCIPALNAME()
D. [User] = USERNAME()
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E. [User] = USEROBJECTID()

Answer: D

Explanation: 
USERNAME() returns the domain name and username from the credentials given to the system at connection time.
It should be compared to column name of User, which in DAX is expressed through [User]. Reference: https://docs.microsoft.com/en-us/dax/username-function-
dax

NEW QUESTION 102
- (Exam Topic 2)
You need to create Power BI reports that will display data based on the customers’ subscription level.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Step 1: Create row-level security (RLS) roles Create roles
Note: Provide all the customers with their own Power BI workspace to create their own reports. Each workspace will use the new dataset in the FinData
workspace.
Implement subscription levels for the customers. Each subscription level will provide access to specific rows of financial data.
Deploy prebuilt datasets to Power BI to simplify the query experience of the customers. Step 2: Create a DAX expression
Consider a model with two roles: The first role, named Workers, restricts access to all Payroll table rows by using the following rule expression:
FALSE()
Note: A rule will return no table rows when its expression evaluates to false.
Yet, a second role, named Managers, allows access to all Payroll table rows by using the following rule expression:
TRUE()
Take care: Should a report user map to both roles, they'll see all Payroll table rows. Step 3: Add members to row-level security (RLS) roles
Configure role mappings
Once [the model is] published to Power BI, you must map members to dataset roles. Reference: https://docs.microsoft.com/en-us/power-bi/guidance/rls-guidance

NEW QUESTION 106
- (Exam Topic 2)
You need to recommend a solution to add new fields to the financial data Power Bl dataset with data from the Microsoft SQL Server data warehouse.
What should you include in the recommendation?

A. Azure Purview
B. Site-to-Site VPN
C. an XMLA endpoint
D. the on-premises data gateway

Answer: D

Explanation: 
Refresh data from an on-premises SQL Server database
The SQL Server database must be accessed by Power BI through an on-premises data gateway.
You can install an on-premises data gateway on the same local computer as SQL Server (in production, it would typically be a different computer).
Reference: https://docs.microsoft.com/en-us/power-bi/connect-data/service-gateway-sql-tutorial

NEW QUESTION 109
- (Exam Topic 2)
You need to integrate the external data source to support the planned changes.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 113
- (Exam Topic 2)
Which two possible tools can you use to identify what causes the report to render slowly? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Synapse Studio
B. DAX Studio
C. Azure Data Studio
D. Performance analyzer in Power Bl Desktop

Answer: BD

Explanation: 
Some users indicate that the visuals in Power BI reports are slow to render when making filter selections.
B: You can investigate a slow query in a Power BI report using DAX Studio, looking at the query plan and the server timings.
D: Use Power BI Desktop Performance Analyzer to optimize the report or model. Reference: https://www.sqlbi.com/tv/analyzing-a-slow-report-query-in-dax-studio/
https://docs.microsoft.com/en-us/power-bi/guidance/report-performance-troubleshoot

NEW QUESTION 115
- (Exam Topic 1)
You need to implement object-level security (OLS) in the Power Bl dataset for the sales associates.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 119
......
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